LENESANS Release Note

RZ/N2H Group

Encoder I/F SSI sample program

Summary
This document describes the RZ/N2H Encoder I/F SSI sample program package.

For Synchronized Serial Interface (SSI) communication protocol specifications and encoder specifications,
contact manufacturer of each encoder to obtain it.

Functionality Checked Device
RZ/N2H Evaluation Board (RTKORZN2HxxxxxxxxX)
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RZ/N2H Group Encoder I/F SSI sample program

1. Package Contents

This package contains the following contents.
The RZ/N2H encoder interface supports up to 13 axes, but the sample program uses only 1 axis of them. If

you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source code

No. name Version
1 RZ/N2H SSI sample program (CR52 ver. *) 3.0
2 RZ/N2H SSI sample program (CA55 ver. *) 3.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name
1 RZ/N2H Group Encoder I/F SSI 3.00 (j) r11an0964j0300-rzn2h.pdf
sample program Release Note (e) r11an0964ej0300-rzn2h.pdf (this document)
2 RZ/N2H Group SSI sample 3.00 (j) r11an0963j0300-rzn2h-ssi.pdf
program Application Note (e) r11an0963ej0300-rzn2h-ssi.pdf
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RZ/N2H Group Encoder I/F SSI sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top

F— r11an0964jj0300-rzn2h.pdf

— r11an0964ej0300-rzn2h.pdf

L— workspace

— Software

| — iccarm

| | F— RZ_N2H_CR52_ssi.zip : RZ/N2H SSI sample program set
| | | CR52 ver. (IAR)

| | L— RZ_N2H_CA55_ssi.zip : RZ/N2H SSI sample program set
| CA55 ver. (IAR)

| — gee

| F— RZ_N2H_CR52_ssi.zip : RZ/N2H SSI sample program set
| | CR52 ver. (e? studio)

| L— RZ_N2H_CA55_ssi.zip : RZ/N2H SSI sample program set
|

CADB5S5 ver. (e? studio)
L— Documents

F— r11an0963jj0300-rzn2h-ssi.pdf

L— r11an0963ej0300-rzn2h-ssi.pdf

The file structure of the RZ_N2H_CR52_ssi.zip and RZ_N2H_CAS55_ssi.zip is shown below.

Top folder
— configuration.xml : FSP configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : SSI sample program
— ssi_main.c : SSI sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— ssi
— iodefine_ssi.h : SSI register definition file
F— r_ssi_rzt2.c : SSI driver file
F— r_ssi_rzt2_config.h : SSlI driver file
F— r_ssi_rzt2_dat.h : SSI driver file
L— r_ssi_rzt2_if.h : SSlI driver file
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RZ/N2H Group Encoder I/F SSI sample program

3. About SSI sample program

This section contains information necessary to use the complete set of SSI sample program.

3.1 Software Information

3.1.1 Base OS
This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and SSI driver is shown in the following table. This table does not
include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 3.7 3.0
Data (with initial value) 0.0 0.0
Data (without initial value) 2.8 2.8
Constant Data 0.2 0.2
Sample program Code 4.2 4.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.6
Constant Data 14 1.8

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 5.0 4.2
Data (with initial value) 0.0 0.0
Data (without initial value) 29 3.1
Constant Data 0.3 04
Sample program Code 71 7.9
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.6
Constant Data 1.6 1.7
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RZ/N2H Group

Encoder I/F SSI sample program

3.2 Hardware Information

3.2.1
RZ/N2H

Device

3.2.2 Target Board
(1) Board Name

RZ/N2H Evaluation Board (RTK9RZN2HOC00000BJ)

(2) Setting of the Target Board
The target board configuration is as follows. Do not push SW4 while you are using channel SSI14.
DSW2-4: ON, DSW2-6: OFF
DSW5-1: OFF, DSW5-2: OFF, DSW5-7: OFF, DSW5-8: OFF
DSW7-1: OFF, DSW7-2: ON

DSW12-5: ON, DSW12-6: OFF
DSW13-3: OFF, DSW13-4: ON, DSW13-7: ON, DSW13-8: OFF

DSW20-5: OFF

DSW21-4: OFF, DSW21-5: ON, DSW21-6: OFF
DSW3-1: ON, DSW3-2: OFF, DSW3-3: ON, DSW3-6: OFF (Set xSPI1 boot mode)

JP8: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
JP9: Short between 2-3 pins (Set VDD1833_3 to 3.3V)

JP23: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3V)

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows. Channels SSI18, SSI12 and SSI15 are not available.

Channel Pin name Pin header | Input/Output Voltage Description
domain
SSI0 ENCIFDIOO (SLO) CN44 #9 Input VDD33 Data input
ENCIFCKO00 (MAO) CN44 #3 Output VDD33 Clock output
SSI1 ENCIFDIO1 (SL1) CN44 #8 Input VDD33 Data input
ENCIFCKO01 (MA1) CN44 #2 Output VDD1833_5 Clock output
SSI2 ENCIFDIO2 (SL2) CN43 #23 Input VDD33 Data input
ENCIFCKO02 (MA2) CN43 #25 Output VDD33 Clock output
SSI3 ENCIFDIO3 (SL3) CN43 #24 Input VDD1833_6 Data input
ENCIFCKO03 (MA3) CN43 #16 Output VDD1833_6 Clock output
SSl4 ENCIFDIO4 (SL4) CN44 #27 Input VDD33 Data input
ENCIFCKO04 (MA4) CN44 #21 Output VDD33 Clock output
SSI5 ENCIFDIO5 (SL5) CN43 #14 Input VDD1833_6 Data input
ENCIFCKO05 (MA5) CN43 #8 Output VDD1833 6 Clock output
SSI6 ENCIFDIO6 (SL6) CN42 #18 Input VDD1833_3 Data input
ENCIFCKO06 (MAG) CN42 #12 Output VDD1833_3 Clock output
SSI7 ENCIFDIO7 (SL7) CN42 #36 Input VDD1833_3 Data input
ENCIFCKO7 (MA7) CN42 #22 Output VDD1833_3 Clock output
SSI9 ENCIFDIO9 (SL9) CN51 #18 Input VDD1833_2 Data input
ENCIFCKO09 (MA9) CN51 #12 Output VDD1833_2 Clock output
R11AN0964EJ0300 Rev.3.00 Page 5 of 15

Nov 21.25

RENESAS




RZ/N2H Group

Encoder I/F SSI sample program

Channel Pin name Pin header | Input/Output Voltage Description
domain

SSIM0 ENCIFDI10 (SL10) CN51 #27 Input VDD1833_2 Data input
ENCIFCK10 (MA10) CN51 #21 Output VDD1833_2 Clock output

SSI11 ENCIFDI11 (SL11) CN51 #26 Input VDD1833_2 Data input
ENCIFCK11 (MA11) CN51 #20 Output VDD1833_2 Clock output

SSI13 ENCIFDI13 (SL13) CN43 #32 Input VDD1833_6 Data input
ENCIFCK13 (MA13) CN43 #26 Output VDD1833_6 Clock output

SSI14 ENCIFDI14 (SL14) CN42 #35 Input vVDD33 Data input
ENCIFCK14 (MA14) CN42 #27 Output VDD33 Clock output
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RZ/N2H Group

Encoder I/F SSI sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H_ rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-04.1
RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CRS52_ssi.zip and copy the extracted source files to the desired location.
Activate EWARM

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_N2H_ssi.eww
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/N2H Group Encoder I/F SSI sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn,
rzn_cfg, rzn_gen, script and .setting folders will be generated.

| @ CA1_Prog\Work\Work_C\Wark_EWA_960_3_fsp3.0.00RZN2H_53_release_chk - FSP Smart Configurator

| File Window Run Help

O 7 Fsp visualization =}

L]

RZN2H_SS|_release_chk] FSP Configuration

Summar
y Generate Project Content

Project Summary A
Renesas
Board RZN2H Evaluation Board (RAM execution without flash memory)
| Device: ROADIGOSTMA4GBG
Core: CR52 CPUO 3
FSP Version: 300 T |

Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_3_fsp3 0.0/RZN2H_SSI_release_chk <=

| Selected software components

Board Support Package Common Files v3.00
Memory Config Checking v3.00
v3.00 v

VO Port

Summary | BSP| Clocks| Pins. Interrupts| Event Links | Stacks| Companents
* § = D0 Bconsole

No consoles to display at this time.

[T Properties (2] Problems

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_N2H_ssi.out is generated.

(4) Sample Program Execution Procedure
After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/N2H Group SSI Sample Program Application Note.

¥ COM10 - Tera Term VT

DAUEDW)  ALTH)

(FLDO 12bi
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RZ/N2H Group
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3.3.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2025-04.1
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.30

(3) Build Procedure of the Sample Program

The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CR52_ssi.zip and copy the expanded source file to the desired location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select

Existing projects into workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

&) RZN2H_SSI_release_chk - & studio
File Edit Source Refactor Nawigate Search Project RenesasViews Run Window Help
K- e it Q-
Project Explorer Lttim]
“ &5 RZ_N2H _ssi [Debug
sl Includes

¢ configurationxmi|

RZ_N2H_ssi Debug_Hatjlink
X| RZ_N2H_ssi Debug_Flatlaunc
?) Developer Assistance

Problems X Console Properties Smart Browser
0 errors, 11 wamings, 0 others
Description Resource Path

1, Warnings (11 items)

¢ configurationxml - RZ_N2H_ssi

|
Q | oL

= 3 = B

Outline x

0

There is no active editor
that provides an outline.

Smart Manual

Location Type

R11ANO964EJ0300 Rev.3.00
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RZ/N2H Group Encoder I/F SSI sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzn, rzn_cfg, rzn_gen, script and .settings folders are generated.

8 RZN2H_SS|_release_chk - RZ_N2H_szi/configuration.xmi - €2 studio - O b
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
5~ & - 6 5~ Q- Q E&crces
Project Explorer X Ll | RZ_N2H_ssi] FSP Configuration Outline X Aka=no
= Summary (¥] There is no active editor that
v 55 RZ_N2H _ssi Generate Project Content I provides an outline.
2l Includes .
- Project Summary A
RENESAS
configurationxmi
RZ_N2H_ssi Debug_Flatlin anrd,. R?f!:l?[i::va;u;r;nn Board (RAM execution without flash memory)
%) RZ_N2H _ssi Debug_Ratian | DYICH: REVOBOEETMA40B0
?) Developer Assistance Coes. Pt
B Toolchain: GCC for Renesas RZ
Toolchain Version: ., 0o,
FSP Version: 300
Project Type: Flat
Location: C:11_Prog/Work/Work_C/Work_E2S_RZ /RZN2H_SSI_release_chk/RZ_N2H_ssi
Selected software components
Board Support Package Commen Files v3.00
Memory Config Checking v3.0.0
1O Port v300 4
Summary| BSP| Clocks| Pins | Interrupts | Event Links | Linker Sections | Stacks| Components
Problems X  Console Properties Smart Browser Smart Manual =0
D errors, 11 wamings, 0 others
Description Resource Path Location Type

i Wamings (11 items)

7 Select [Project] menu -> [Build All]
The Debug\RZ_N2H_ssi.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/N2H Group SSI Sample Program Application Note.

[ COM10 - Tera Term VT - O X
(5 IxbO-O) PqvEoW)  ALTH)
rt
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RZ/N2H Group
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-04.1
RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CA55_ssi.zip and copy the extracted source files to the desired location.
Activate EWARM.

2
3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_N2H_CA55 0_ssi.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO964EJ0300 Rev.3.00
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RZ/N2H Group Encoder I/F SSI sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn,
rzn_cfg, rzn_gen, script and .setting folders will be generated.

| I8 CA\1_Prog\Work\Work_C\Work_EWA,_060_3 fsp3.0.0\RZM2H_SSI_CASS_release_chk - FSP Smart Configuratar = u] x|
| File  Window Run Help
RZN2H_SSI_CAS5 _release_chk] FSP Configuration X ™) “F Fsp visualization =l
Summary Generate Project Content LY
Project Summa A
) i RENESAS
Board RZN2H Evaluation Board (RAM execution without flash memory) 209
Device: RIADIGOSTMA4GBG
Core: CAS55 Core0
FSP Version: 300
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96.. p3.0.0/RZN2H_SSI_CAS55_release_chk
Selected software components
Board Support Package Common Files v3.00
Memory Config Checking v3.00
1O Port v3.00 ™

16

Summary | BSP| Clocks | Pins| Interupts| Event Links| Stacks | Components

*# § =0 Bconsole

No consoles to display at this time.

Properties [2] Problems

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_N2H_CA55 0_ssi.out is generated.

(4) Sample Program Execution Procedure
After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/N2H Group SSI Sample Program Application Note.

v COM10 - Tera Term VT
JrAIUF)  REI(E) (5 IvRO-LO) 24VFOW)  ALTH)
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RZ/N2H Group Encoder I/F SSI sample program

3.4.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2025-04.1
Toolchain version: GCC Arm A-Profile (AArch64 bare-metal) 10.3.1.20210621
RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.30

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CA55_ssi.zip and copy the expanded source file to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing projects into workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

ﬁ RZM2ZH_S51_CAS5_release_chk - ¥ studio — (] X
File Edit Source Refactor MNavigate Search Project Renesas Views Run Window Help
IR g o idpr Qv Q im| s
Project Explorer x == =6 QOutline > =20 =
| = 8 There is no active editor ca
| v 5 RZ_N2H_CA55_0_ssi [Debug] that provides an outline.
nil Includes

.
9
oy ccnﬁgurationxml‘
RZ N2H_CAS5.0._ssi Debug
X| RZ_N2H_CAS55_0_ssi Debug
?) Developer Assistance

=

Problems X Console Properties Smart Browser Smart Manual 8 (%]

0 errors, 11 warnings, 0 others
Description Resource Path Location Type

L Wamnings (11 items)

t or configurationxml - RZ N2H_CAS55 0 ssi
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RZ/N2H Group Encoder I/F SSI sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzn, rzn_cfg, rzn_gen, script and .settings folders are generated.

T T o T = = 3
) RZNZH_SSI_CASS _release_chk - RZ_N2H_CAS55_0_ssi/canfigurationxml - & studio = (u] x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

&~ © v Qv Q Egc/c++
Project Explorer = 0 RZ_N2H_CAS5_0_ssi] FSP Configuration Outline X BAac=0
= Summary ] There is o active editor that o
v 155 RZ_N2H_CA55.0 ssi Generate Project Content | provides an outline.
sl Includes X
= Project Summary ~
RENESAS
configurationxmi 3
RZ_N2H_CAS5.0_ssi Debug_Fla Board: RZN2H Evaluation Board (RAM execution without flash memory)
| RZ_N2H_CASS 0 ssi Debug Fla | DeV1e® PO ALOS
- Core: CA55 Core0
Developer Assistance -
Toelchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 10.3 1.20210621
FSP Version: 300
Project Type: Flat
Location: C:1_Prog/Work/Work_C/Work_E2S_RZ.. A55_release_chi/RZ_N2H_CAS55_0_ssi <=

Selected software components

Board Support Package Common Files v3.00
Memory Config Checking v3.00
1O Port v3.0.0 s

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Linker Sections | Stacks| Components

| Problems Console Properties Smart Browser Smart Manual = [=f
| 0 errors, 11 wamings, 0 others
Description Resource Path Location Type
1 Warnings (11 items)

7 Select [Project] menu -> [Build All]
Files Debug\RZ_N2H_CA55 0_ssi.elf is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/N2H Group SSI Sample Program Application Note.

"1 COM10 - Tera Term VT - (m] X
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rt
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Rev. Date Page Summary
2.00 Dec 23.24 - First Edition issued
3.00 Nov 21.25 2,3 Update revisions of the application note and the release note.
Update sample program version to 3.0. (Support FSP v3.0.0.)
4 Update memory size information.
71014 Update build environment for FSP v3.0.0. Figures are replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2025 Renesas Electronics Corporation. All rights reserved.
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